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ABSTRACT

In spite of broad research, the design of water distribution networks are not realized using
optimization techniques primarily, because design of water distribution networks is considered
generally, as a least-cost optimization problem where pipe diameters being considered as the only
decision variables.One of the major factors that motivates to analyze the water distribution network
problem, is the complexity of algorithms generated using linear programming, and their non friendly
nature. Hence, with the passage of time, several computer codes/software’s have been developed to

make these problems user friendly and simple.

In fact, domestic water distribution network systems are quite complex systems such that it is not
easy to obtain most reliable and economically efficient systems considering ,constraints such as
reliability, in addition to classical constraints related to hydraulic feasibility, satisfaction of nodal
demands and requirement of nodal pressures. This study represents a user-friendly package
concerning the design of water distribution networks by optimization using reliability considerations;
this works employs the algorithm proposed by Jacobs and Goulter 1989.At the end, a systemized
network design is offered.The schematic network is constructed using commercial software Bentley
WATERGEMS V8i which is also used to simulate the results.

This study provides an approach for assessing the performance and reliability of a selected network
for urban residential area.Chapter 1 of this study gives the basic introduction of water distribution
systems,methods used to analyse the networks,objective and brief introduction of methalodolgy of
the network simulation. In Chapter 2, a brief review of the optimization techniques of water

distribution networks and water distribution system is discussed in short.

In Chapter 3, methodology involved in the study that is linear programming, which is used in case
studies was presented. In Chapter 4, Network study using WaterGEMS software is discussed,

working mechanism of the software is described in detail.

Further Case study is presented in Chapter 5.Results and modifications of data are presented in
Chapter 6,and

Finally Chapter 7 presents the conclusions of the study.

Keywords: Water Distribution Systems,Bentley WaterGems V8i, Reliability, Linear Optimization,
Least cost Design, Water Distribution Network of Block-B Surajmal Vihar,New delhi.
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CHAPTER 1

INTRODUCTION

1.1 GENERAL

A water distribution system is a hydraulic infrastructure which transports water from the source
of the consumers; mainly it consists of elements like pipes, valves, tanks and pumps.The most
important consideration for the design and operation of water distribution systems is that it should
satisfy consumer demand in two series of number and quality of courses throughout the life span
of expected loading conditions. as well as that; Water distribution system needs to include
abnormal conditions such as, inaccurate demand forecasts, breaks in pipes valves, and,
malfunction storage facilities, control system power outages and mechanical failure of pipes.
Maligned occurrence of each gap BOR Set examined two overall performance and thus the
reliability of the system. In general, the reliability has been defined as the probability of the system
operated successfully within specified limits for a certain period of time in a specified
environment. As defined above, the reliability of the system is the capability of system with two
levels of service provider to consumers, normal and abnormal conditions. However, it is still not
a practical assessment of the reliability of the water supply system.

Traditionally, water distribution network design is based on the level of the street plan and
topography. Using commercial software, the modeler simulates the flow and pressures and off the
network and flow into and to / from the tank unnecessary burdens. In this exercise, the modeler
depends primarily on its / his experience. However, even a small supply network containing
pipes/cisterns of the order thirty can require millions of combinations of pipes not including
pumps, tanks and valves. It is hardly possible that modeler, using traditional modeling practices,
find the best solution even for a small network of lowest cost design. So why is optimization

techniques applied to the design WDN.



1.2 WATER DISTRIBUTION SYSTEMS

1.2.1 INTRODUCTION:

Distribution system is a network of pipelines that distribute water to the consumers.They are
designed to adequately satisfy the water requirement for a combination of

eDomestic,

eIndustrial,

eCommercial and ,

eFire Fighting requirements
1.2.2 Requirements of Good Distribution System

e Water quality should not get deteriorated in the distribution pipes.

e |t should be capable of supplying water at all the intended places with sufficient pressure
head.

e |t should be capable of supplying the requisite amount of water during fire fighting.
e The layout should be such that no consumer would be without water supply, during the
repair of any section of the system.

e All the distribution pipes should be preferably laid one metre away or above the sewer

lines.

e |t should be fairly water-tight as to keep losses due to leakage to the minimum.
1.2.3 Layouts of Distribution Network

The distribution pipes are generally laid below the road pavements, and as such their layouts
generally follow the layouts of roads. There are, in general, four different types of pipe networks;

any one of which either singly or in combinations, can be used for a particular place. They are:

1. Dead End System
2. Grid Iron System
3. Ring System

4. Radial System


http://nptel.ac.in/courses/105104102/Dead%20end%20layout.htm
http://nptel.ac.in/courses/105104102/Grid%20iron.htm
http://nptel.ac.in/courses/105104102/Ring.htm
http://nptel.ac.in/courses/105104102/Radial.htm

1.Dead End System:

It is suitable for old towns and cities having no definite pattern of roads.

Dead End or Tree System

_ @] L ®
® I T
® . ®
® JL@) ) : Main Pipe

: Branch
: Sub Mains

e : Cut oft Valves

® _l,_]® ®
| @F
Fig 1.1 Layout of dead end or tree system

Advantages:

1. Relatively cheap.

2. Determination of discharges and pressure easier due to less number of valves.
Disadvantages

1. Due to many dead ends, stagnation of water occurs in pipes.



2.Grid Iron System:

It is suitable for cities with rectangular layout, where the water mains and branches are laid in

rectangles.
Grid-iron System
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Fig 1.2 Layout of Grid iron System
Advantages:

1. Water is kept in good circulation due to the absence of dead ends.

2. In the cases of a breakdown in some section, water is available from some other direction.
Disadvantages

1. Exact calculation of sizes of pipes is not possible due to provision of valves on all

branches.



3.Ring System:

The supply main is laid all along the peripheral roads and sub mains branch out from the
mains.Thus,this sysrem also follows the grid iron system with the flow pattern similar in

character to that of dead end system.So,the determination of pipe size is easy.

Ring System
&
= <«<— V| —> —
|
W% & |
L ® @
V5T o To "f’
olo losl' Gilenre
J« ® €), l (S): Sub Mains
0 4! o : Cut off Valves
&

Fig 1.3.Layout of Ring system
Advantages:

Water can be supplied to any point from at least two directions.

4. Radial System:

The area is divided into different zones. The water is pumped into the distribution reservoir kept

in the middle of each zone and the supply pipes are laid radially ending towards the periphery.



@ lRadial System
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Fig 1.4.Layout of Radial system

Advantages:

1. It gives quick service.

2. Calculation of pipe sizes is easy.

1.3 Pipe Network Analysis
Analysis of water distribution system includes determining quantities of flow and head losses in
the various pipe lines, and resulting residual pressures. In any pipe network, the following two

conditions must be satisfied:

1. The algebraic sum of pressure drops around a closed loop must be zero, i.e. there can be

no discontinuity in pressure.
2. The flow entering a junction must be equal to the flow leaving that junction; i.e. the law of

continuity must be satisfied.



Based on these two basic principles, the pipe networks are generally solved by the methods of
successive approximation. The widely used method of pipe network analysis is the Hardy-Cross

method.
1.3.1 Hardy-Cross Method

This method consists of assuming a distribution of flow in the network in such a way that the
principle of continuity is satisfied at each junction. A correction to these assumed flows is then
computed successively for each pipe loop in the network, until the correction is reduced to an

acceptable magnitude.
If Qa is the assumed flow and Q is the actual flow in the pipe, then the correction d is given by
d=Q-Qa; or Q=Qa+d
Now, expressing the head loss (HL) as
HL=K.Q~
we have, the head loss in a pipe
=K.(Qa+d)*
=K. QX + x.QXd + ......... negligible terms]
=K.[Qa* + Xx.Q21d]
Now, around a closed loop, the summation of head losses must be zero.
or, SK.[Q+x.QX]=0
or SK.Q*=-SKx Q.*d
Since, d is the same for all the pipes of the considered loop, it can be taken out of the summation.

or SK.Qu*=-d. SKx Q1!



or d=-SK.Q Sx.KQ.*"

Since d is given the same sign (direction) in all pipes of the loop, the denominator of the above

equation is taken as the absolute sum of the individual items in the summation. Hence,
or d=-SK.QX/SIx.KQ:?I
or d=-SHL/x.SIHL/Qal
where Hy is the head loss for assumed flow Q..

The numerator in the above equation is the algebraic sum of the head losses in the various pipes
of the closed loop computed with assumed flow. Since the direction and magnitude of flow in these
pipes is already assumed, their respective head losses with due regard to sign can be easily
calculated after assuming their diameters. The absolute sum of respective KQz** or H./Qa is then
calculated. Finally the value of d is found out for each loop, and the assumed flows are corrected.

Repeated adjustments are made until the desired accuracy is obtained.

The value of x in Hardy- Cross method is assumed to be constant (i.e. 1.85 for Hazen-William's

formula, and 2 for Darcy-Weisbach formula)

1.3.2 Dead-End Method

Determine the locations of "dead-ends" providing that water will be distributed in the

shortest way. At the dead-end points there will be no flow distribution.

Dead-end Dead-end

N / /

Branch system

Loop system

Dead-

Quegin Qend

Fig 1.5 Layout of dead end method of network analysis
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To apply dead-end method for loop systems, convert it to branch system. To do this, a dead-
end point is identified for each loop. The location of dead end point is chosen such that
distance travelled to reach dead-end point from 2 different directions will almost equal to

each other. Because; in a closed loop

e Start calculations from dead-ends to service reservoir.
e Calculate the total flowrate to be distributed (Qmax_h + Qfire)

e To calculate design flowrate of each pipe;

To calculate Q dgistributed:

* Population density coefficients (k) are calculated from the areas to where water to be

distributed. Population density in each area is determined according to number of

stories:
Number of storey 1 2 3 4 5
One-sided buildings 0.5 1 15 1.75 2
Two-sided buildings 1 2 3 35 4
Unit of k = population/m length of pipe
Hy calculation according to Darcy-Weisbach:
H, =k.Q%L
Where, k = I
D.A%22g

Where f is the friction factor for pipes,for different pipe materials,it is different.D is the diameter
of the pipe in mm,A is the cross sectional area,while g is the value of accelartion due to gravity (g)

is taken as 9.81 m/sz2.



1.3.3 Equivalent Pipe Method

Equivalent pipe is a method of reducing a combination of pipes into a simple pipe system for
easier analysis of a pipe network, such as a water distribution system. An equivalent pipe is an
imaginary pipe in which the head loss and discharge are equivalent to the head loss and discharge
for the real pipe system. There are three main properties of a pipe: diameter, length, and
roughness. As the coefficient of roughness, C, decreases the roughness of the pipe decreases. For
example, a new smooth pipe has a roughness factor of C = 140, while a rough pipe is usually at
C = 100. To determine an equivalent pipe, you must assume any of the above two properties.
Therefore, for a system of pipes with different diameters, lengths,and roughness factors, you
could assume a specific roughness factor (most commonly C =100) and diameter (most
commonly D =100 mm ). The most common formula for computing equivalent pipe is the Hazen-

Williams formula.

[ Nes!

® @ — ®

Figure 1.6 Layout of pipe system for equivalent pipe problem
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Applying Darcy-Weiscbach equation:

HL == k QZ. L
Where, k = f
D.A%2g
H=K.Q?
.L
Where k = /
D.A%2.2g
Applying Hazen William:
H._:K.Ql'85
L .
Where K = for Sl units

(0.278CD)?:62

Recalculate the headloss in each of the original pipes. Sum the headloss from each node to the

next one, recognizing that there are two ways of getting from node B to node D (use either one,

but not both).

11



1.4 OBJECTIVES OF STUDY:

Most of the optimization program to define the basic design problem as to minimize the cost of
pipe subject to :

1) Understanding the basic principles of creating a Water distribution Network.

2) Construct a network of given area of study (B-Block Surajmal Vihar,New Delhi)

3) Check the network for satisfaction of the velocity and pressure controls, and

4) Nodal demands satisfaction.

5) Analyze the Network for least cost.

6)Suggest the modifications for the network for future studies.

However, modelers must take into account, in particular, reliability issues and also monetary
limits.

Optimization of a water distribution system quite complex because nonlinear relationship between
parameters. Recently, a significant amount of research has been carried out on the optimal design
of water distribution network. Some of the first studies using linear programming (LP); subsequent

studies applied nonlinear programming (NP) and study the genetic algorithm (GA).

1.5 SCOPE OF THE STUDY

e Incorporation of latest technology and computer algorithims to WDNSs,for better and
detailed analysis of networks.

e A significant amount of research on optimization techniques for the design of WDNs
operate for years and there are theories about optimization. But, not many of the theories
reflect the complexity of the modes and difficulty of the technical application of theory to
real networks.

e Currently, it is easier to model the optimization theory with the help of computers. As cities
go, claiming the importance of capital and maintenance costs of managing large networks
using the optimization techniques,

e For instance a systemized form of the B-Block Surajmal Vihar,New Delhi is designed

under various reliability Conditions

12



e Developing technologically advanced optimized solutions for building WDNSs.

1.6 METHODOLOGY

1.Study location: Water distribution network of Surajmal vihar(B-block),New delhi.
2.Data Collection on WDN of selected area of study includes: Area layout, age of network,
population of study area, pipe type, installed reservoirs and no.of nodes/junctions to be
provided,etc.

3.Construction of WDN using WaterGems v8i with the Plan of area provided by Delhi Jal
Board(DJB).

4.Satisfying the network for nodal demands.

5.Validation of design by obtaining FleX tables for junctions,pipes and nodes respectively.
6.Determination of junctions/nodes not satisfying or meeting the pressure demands
7.Modifying the network ,by changing diameter or addition or reduction of junction or nodes in
the network.

8.Considering the peak factor Fluctuations in demand and supply

9.Analysing the network for least cost design (pipe materials).

10..Selecting the economically efficient and sustainable network for the final review.

1.7 ASSUMPTIONS INVOLVED IN STUDY

e The Project involves certain assumptions of various fittings in the network function, and
there is sufficient water supply to meet the demands of all residents of the area.

e In general, a daily per capita water consumption is taken as 70 LPCD,but as per
CPHEEO recommendations(oct’2011),per capita consumption has been increased to 135
LPCD,the additional demands involves floating population, fire demands, institutional
demands

e 15% losses should be considered on the rate of demand (135 LPCD)only.

e Division of water supply zones and sub zones should be minimized duly considering

existing network, physical barriers and topographical nature.
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The distribution system should be designed with a peak factor of 3, having population less
than 10000.

The minimum pressure at ferrule point should be 7m(as per CPHEEO),and maximum
should be 22 m for multi storeyed buildings. For pressure to be achieved higher than this

point, pumps should be installed with adequate power.

The topology of entire area is taken as flat.

100% stand-by for pump sets shall be provided for pump set capacities of 60 or less and
50% and by pump sets shall be provided for capacities of less than 60 KW(CPHEEO).

No seismic activities have been taken into account in the building up for networks.

No corrosion, water leakages or pipe blockages have been taken into account that might
affect performance of network in any case.
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CHAPTER 2

LITERATURE REVIEW

2.1 Optimization studies in the water distribution network

(Ormsby et al. (1989) Lanes and Bancenet (1991).This chapter gives a brief overview of
optimization techniques for water distribution systems and water supply system/networks. With
regard to water distribution networks are various applications of optimization methods. These
applications can be classified into three categories: (1) Calibration Study, (2) Functional Study,

(3) Rehabilitation Design / Development / Study.

2.1.1 Calibration Studies

Walsky (1983) The composition of a calibrated hydraulic network model involves adjusting the
selected parameters by comparing their measured and calculated values. If the selected
parameters of the network are pipe roughness and nodal demand, a specific procedure for
determining the specific roughness values for the pipes and specific nodal demands of the nodes
should be done, which reduce the difference between the field (in the field) and the calculation
Will (value using the hydraulic model) In the optimization-based model, the objective function
(the difference between measured and calculated values) is minimized while reducing

satisfactory constraints, which describes a viable solution

The decision to sample the places to measure the pressure is another issue in calibration.
proposes that measurements should be near major demands and near the border of pressure area;
Also, it was Advised that sample points should be away from sources. However, it is difficult to
determine the precise location of the sample points; Because, to test the hydraulic model, test

data should have already been received (sample points' locations must be fixed in advance) after
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the placement of the test, on hand, calibration parameters (resistance coefficient and Nodal
demand) can be achieved. Consequently, keeping in mind the sensitivity of the network, an

iterative process should be realized.

Procedure for choosing sample points is done by Bush and Uber (1998), Pilar, et al. (1999),
Mayer & Barkdol (2000)

2.1.2 Operation Studies

Ufixe (1994) and Persian et al. (1997) Generally, a large percentage of the total expenditure for
energy sectors was for water services. It becmes critical to arrange and organize the operations of
all the pumps to minimize energy consumption Kansampsn. Jovitt and Jrmnopulos (1992)
Proposed a linear programming model (LP) while Ufixe (1994) and Persian et al. (1997)
Proposed a nonlinear programming model The use of commercial software applications were
the basic advantages of using the LP and prospects for the use of global friendly, while on the

other hand, the loss of information, due to linearization was major Disdvantage.

2.1.3 Design of Optimal Water Distribution Networks

Aksomplishd B Scnke End (1969). Walski (1985) General objective of the project of the water
supply problem network aims at full cost minimization of network Scenes these systems are
expensive Infrastrctors. System optimization, but in my water distribution ratios between
nonlinear parameters to pay this Killer file. Last Signified AMOUNT Research was conducted
on the optimal water supply network Tablet project. One of the first computer-generated habitat
optimization studies Revivewd Approximtely one hundred study on optimization scenarios
today. Over the next fifteen years, another significant increase is the habitat field Obsserved.
Study.

Optimizing Problem The New York Tunnel Es (Skanke and Lai, 1969), and various real systems
(Jacobsen et al., 1998) were carried out between oters. Aksording if Walski (2001), were the
algorithms that were developed until yesterday, were not simulated the entire course construction

was closed. For example, (1) not so far Were Rilaybiliti considerations applied Note Habitat
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restrictions Realistikli (2) included (3) Benefits were Knsidered Note et al. Did Walski (2001)
mention Bikoz these and packing Unfarandli's exclusion related software, a technical design

using traditional tools to continue.

Theoris quantity has been coupled with the powerful Avelebiliti Inakspensive hardware, Theoris
development have been in the past three Dades Haas have been improved Knsiderably ability to
simulate hydraulic behavior of large water supply networks (Rossmn, et al., 1993). These models
play an important role in the design, operation and design of water saturation distribution
systems. The selection of Diametrs pipe from the set of Kmersialli Diametrs available capital to
establish a water supply network at the expense of Huss Bean Shawn then hold on to a difficult
problem. The cost of maintaining and operating the Knsiderable Bay water distribution system is
May, but it was always the cost I was hugging OF Temselves pipeline. In recent years, the
number of HVE Bean Tablet Optimization Techniques Developed for Primrily on the Cost of
Networking Minimiztion, Altug alone tested Rilaybiliti and modeled the stochastic HVE Bean

test requirements.

Some of them were first used in linear programming studies Vere Prformed B Alperovits and
smir (1977); Kvindray et al. (1981), and Smir and Howard (1985). Although the recent
Nonlinear Programming of Applied Sciences (NP) Su et al. (1987); Valkeakoski and Mace
(1989); Xu and Goulter (1999), and the limited case and Valkeakoski Mace Approaches (1989)
were the problem of pipe network optimization. Bean Shed and some more adwantages more
traditional methods of optimization (Simpson et al. (1994).) Svik and Waters (1997). ).

The problem of optimization of the New York tunnel Es (skank and Lai, 1969), and various real
systems (Jacobsen et al., 1998) have been between oters. Aksording if Walski (2001), were the
algorithms were developed until yesterday, are not simulated the whole construction of the
course was closed. For example, (1) are not currently considered Rilaybiliti enforced restrictions
Realistikli habitat Note (2) included (3) Benefits were Knsidered Note et al. Is Walski (2001)
mentions Bikoz Ces and Unfarandli packaging exclusion software related, and technical design

using traditional tools to continue.
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Theorizing quantity has been coupled with the powerful hardware Theoretical Innerpilitis
Indspensive Theorising have been improved the three past Haas Dades is the ability to simulate
Knsiderably hydraulic behavior of large water supply networks (Rossmn, et al., 1993). These
models play an important role in the design, operation and design of saturation of water
distribution systems. The selection of the Diametrs pipeline of the whole available capital
Kmersialli Diametrs ESTABLISH is a water supply network at the expense of Huss Bean Shawn
then hold onto a difficult problem. The cost of maintaining and operating the Knsiderable Bay
water distribution system may be, but it was still the cost that I was hugging the Temselves
pipeline. In recent years the number of HVE Bean Tablet Optimization Techniques Developed
for Primrily on the cost of the Minimiztion network, Altug alone Rilaybiliti tested and modeled

the stochastic HVE Bean Test Requirements.

Some of them were first used in the linear programming studies Vere Prformed B Alperovits and
Smir (1977); Kvindray et al. (1981), and Smir and Howard (1985). Although the recent
Nonlinear Program of Applied Science (NP) Su et al. (1987); Valkeakoski and Mace (1989);
Goulter and Xu (1999), and the limited case and Valkeakoski Mace Approaches (1989) were
problems of network optimization of pipelines. Bean Shed and some other more traditional

methods of optimization (Simpson et al., 1994). Svik and Waters (1997). ).

2.2 Water Distribution System Reliability

American Water Works Association (1974) olefins has a water distribution system as one
"including all components of the water to the distribution of finished liquor or water by gravity
feed storage The cluster or a pump by storing distribution equalizer. "The cost of capital is first
set up and the operating costs, maintenance and repair time for end-user water network services
are wide; Designers are trying to reduce the overall cost of the system. This goal is very difficult
to deal with the minimum cost solution for obtaining water from the system due to the large
number of parameters that affect the costs. While optimizing the system designer must take
expected and unexpected loading needs into consideration in order to ensure the water supply to
the end user. The most important aspect in the design and operation of the water supply system is

to meet the needs of customers in the desired range of qualitative and quantitative systems during
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the "whole life for expected load conditions. In addition, the water distribution system must be
reliable in order to adjust conditions such as abnormal breaks in pipes, mechanical damage to
pipes, valves and control systems, power outages, failure of storage facilities And inaccurate
demand forecasts. The possibility of occurrence of each of these defects should be tested in order
to determine the overall performance, and thus the reliability of the system. Generally, reliability
is defined as the probability that the system performs the specified limits for a given period of
time in a particular environment. As defined above is the reliability of the systems' ability to
provide the appropriate level of system services for consumers under both normal and abnormal
conditions. However, there is still no practical way to assess the reliability of the water
distribution system, as there are many measures of reliability. Review of the literature, Mays
(1989) shows that there is no universally acceptable definition or measurement of the reliability

of the water distribution system is now available.

2.3 Reliability considerations in the Least-cost Design of Water Distribution

Networks

Over the past years, considerable effort has been devoted to the development of optimization
algorithms and models for the design of water distribution networks. Many of these theories have
the objective of minimizing the both capital and operating costs. (Alperovits and Shamir, 1977;
Quindry et al., 1981; Shamir and Howard (1985); Lansey and Mays, 1989; Eiger et al., 1994;
Simpson et al., 1994; Savic and Walters, 1997) However, in practice, the optimal design of a
water distribution network is a complex multiple objective process involving trade-offs between
the cost of the network and its reliability, Xu and Goulter, (1999). Reliability incorporated
optimization of water distribution systems requires combination of an optimization algorithm

with a method for estimating reliability..

The term “‘reliability’’ for water distribution networks does not have a well-defined meaning.
Nevertheless, it is generally understood that reliability is concerned with the ability of the
network to provide an adequate supply to the consumers, under both normal and abnormal

operating conditions (Goulter, 1995).
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The first explicit considerations of probabilistic issues in the reliability of water distribution
networks were reported by Kettler and Goulter (1983), who included the probability of pipe
breakage as a constraint in an optimization model for the design of pipe networks. Then, Goulter
and Coals, (1986) developed a quantitative approach to reliability measure in an optimized
looped network. This approach begins by obtaining an “optimal” layout design through linear
programming. Then, approach addresses the probability of isolating a node through simultaneous
failure of all links connected directly to that node. The probability of failure of individual links is

modeled using the Poisson probability distribution.
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CHAPTER 3

METHODOLOGY INVLOVED: LINEAR PROGRAMMING

This methodology,aims to determine the different pipe sizes and their associated lengths so as to
minimalize the cost of the network/system while satisfying the criteria of hydraulic feasibility
and reliability requirements, this method is derived from a model developed by Alperovits and
Sh mir (1977) which in turn is originated from an earlier model developed by (Goulter and Coals
(1986) and described below.

Optimization tried to find best diameters for network links to reach optimum result.

In this method,assumed unknown parameter for any link is not the pipe diameter but the lenghts
of available pipe diameters,Xix.

Obijective Function:

Minimize, C:Z ijjln,?;)l cjk. Xi (3.1)

Subject to the following constraints:

3.1. Computation of Length: The summations of individual lengths of pipes in each link/node
should be equal to the total length of the pipe/node ,where a link represents a pipe linking two

nodes directly.

Z(zjl) Xik=Lj For all links | 3.2)
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3.2. Computation of Head loss: Minimum and maximum permissible head at each demand point

or node must be satisfied.

nif)

H,- Z ZJ}k'Xﬂg 2 H ymin  Forall nodesn (3.3)
M= pinik=l
nij)

H,- Z ijk'Xjk < H jmax  Forall nodesn (3.4)
JjE plnalk=1

3.3. Analysis of Loop: For a close looped system, the total head loss around a loop must equals
Zero.

3.4. Check for Non-negativity:

Xt 20 Foralljand & (3.6)

3.5. Reliability Analysis: The measure of reliability is included into the constraint set by Equation

3.7, which limits the expected (average) number of breaks in given time period in any link.

(i
k(=]1) Tik.Xjk < Rj For all links j 3.7)
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: Cost of pipe of diameter K in Link (X/km)

: Total Cost of system (%)

: minimum allowable head at node n (m)

: maximum allowable head at node n (m)

- original head at source (m)

- hydraulic gradient for pipe diameter k in link j (m/km)

: total length of link j (km)

: number of different pipe diameters in link j

: total number of links within the system

> links in the path from source to node n

- links in the path associated with net head loss By

: expected number of breaks/km/year for diameter k in link j
: maximum allowable number of failures per year in link j
: length of pipe of diameter k in link j (km)

- link index

: diameter type index
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CHAPTER 4

NETWORK STUDY:WATERGEMS V8i

4.1 Designing A water Distribution Network(WaterGems)

WaterGEMS — How to Design a Water Distribution System When you open the program so as to
make a New Hydraulic Model the initial step you ought to do is to affirm the units you are taking
a shot at. Pick Tools > More > Options, tap on the Units tab and afterward Reset Default catch and
select Sl. In addition, tap on the Drawing tab to ensure scaling of data . For example setting the
plot scale consider: 1cm = 40m. To set up the Hydraulic Model pick File > Hydraulic Model
Properties and name the water powered model and snap OK. Enter the document name for your
model and snhap Save. The subsequent stage is to lay out the system, to do as such you can utilize
a foundation document. Select View > Backgrounds to open Background layers chief. Tap Right
on the Back ground Layers organizer and select New > File. On the Select Background exchange

you can peruse your .dxf, .jpeg or numerous different sorts of record arrangements.

4.1.1 Drawing a water supply/distribution network

1. Pumping System — Reservoir + Pipe + Pump + Pipe + Reservoir

From the Home tab select the Layout. Move the pointer to the drawing dropdown menu, right
click, and select Reservoir from the menu, click to place on it. Drop the cursor to the location of
the Reservoir, right-click and select reservo ir from the sho rtcut menu. Cljck to placejt. Bétween
R-1 and PMP-1 you can see P-1 is formed pipes are connected in a systematic manner connecting
with the reservoir.For addition of more pipes,nodes are required to be created with this idea select
junction from the dropdown menu and place it accordingly. More pipes can be added by creating
more juntions and nodes in order to form a sophisticated pipe network,but with the increased
junctions and nodes,the network will be complex.Once done right-click and select Done from the

dropdown menu.
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In the event that fundamental you can add to your plan things, for example, a Tank and a valve

PRV from the list of components and associate them to your framework as done earlier with the

supply, pump and intersections.

4.1.2 Entering and modification of data: Property Editor

Reservoir — open the Réservoir Editor by double tapping on R-1. Enter the height in meters.
Likewise, you need to set Zone to Connection Zone. Keeping in mind the end goal to do
this, in the Supply Editor, underneath the height parameter, tap the menu to Edit Zones
which will open the Zones Manager. Click New and enter a layer for the new weight zone
called Connection Zone. Click close and select the zone you just made from the Zone menu.

Close the Reservoir Property Editor.

Tank - If you intend to build to have a tank, double tap on tank T-1 and alter these changes
in the menu: Elevation (Base) = 250 m, Elevation (Minimum) = 220 m, Elevation (Initial)
= 215 m, Elevation (Maximum) = 276 m, Diameter (m) = 10, Section =
Circular/Cylndrical. Additionally you should make Zone-1 in the Zone Manager, similarly
Connection Zone was made. Accordingly,Set the Zone to Zone-I in the menu ofTank

Property in the Editor.

Pump — Double tap on pump PMP-1 and enter value of elevation of the area. Select the
pump definition field and Click on Edit Pump Définitions starting from the dro p rundown
to o pen the Pimp Définitions Manager. Click Néw and make another pimp definition.
Choose any name for th epump definition illustration PMP-1. Select Standard (3 Point)
from the Pump Definition menu. You ought to right tap on Flow to open the Units and
Formatting menu accordingly to set the Units to L/min in the Set Field Options Option
dialog boxes. Now, you ought to enter user defined values for the stream outline (3600
L/min) and max working (6500 L/min) and for the head shutoff (25 m), outline (26,40 m)
and maxm operating (26,80 m). Close the Pump Definitions Administrator and select PMP-

| as user defined pump
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e Valve (PRV) — For entering the valve,Do uble click o n thé valvé in the network(drawing).
Then,Enter the following data: Status (Initial) = Active, Sétting typé = Préssuré, Préssureé
sétting (nitial) = 380 kPa, Elavation = 168 m, Diameter (Valve) = 180 mm. Also, create
Zone 2 and set Zone field to Zone Il. After entering the data,Clo se the PRV Property
Editor.

e Junction — Enter Values for ground rise/elevation (m), request and zone information for all
the Junctions in the Junction Propertiy Edito r. Leave every single other field set to their
default values. With respect to Demand, click on the Demand Collection field to access the
Demand Manager tab and enter values for the the Demand Base Flow (L/min). Right Click

on the Demand (Base) section >> Units Formattiing >> and set Units to L/min.

e Pipes— If you have to indicate client characterized lengths for Pipes, double tap on the pipe
to access the Pipe Property Editor. For instance, of the pipe P-1, since you are utilizing the
reservoir and pump to optimize the water distribution network, desired head loss through
the pipe should supposedly be negligible . Hence, the length will be considered very small
and the diameter too large. For instance ,you can enter 900 mm as the Diameter of P1. Set
the Has User Defined Length? For yes , that point you can enter an estimation of 0.9 m
in the length field, just for an example. For rest of the network, lengths can be altered but

not diameters unless required.

Rather than Property Editor, WaterGEMs enable us to view and edit the properties of numerous
components simultaneously with the help of FlexTables (other alternative to enter and change

information).
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4.1.3 Running Steady-State Analysis for the network:

Click Analysis > Options to open the Calculation Options chief. Double tap Base Count
Options under the Steady-State/EPS Solver going to open the Property Editor. You ought
to set aside a few minutes Analysis Type is set to Steady State. Close the Property
Supervisor and the Calculation Options chief. At that point, click Analysis > Validate and

if everything is alright snap Compute on the Home or Analysis tabs to examine the model.

4.1.4. Extended Period Simulation (EPS):

To run an extended period simulation it is necessary to create demand patterns. Therefore,
open the Property Editor for a Junction and click in the Demand Collection field to open
the Demands box. Enter a demand in I/min for Flow and click in the Pattern (Demand)
field to open the Patterns manager. Once there, highlight the Hydraulic folder and click
New to create a hydraulic pattern. Rename the new pattern, enter a start time and enter a
Starting Multiplier like 0.5. In the Pattern Format menu select Stepwise. Note that the
multiplier for the last time given (24h) must be the same as the Starting Multiplier. These
values are equal because the demand curve represents a complete cycle, with the last point
being the same as the first. Under the Hourly tab, enter the times and multipliers for the
demand requested. Close the boxes and enter the demand data for the remainder junctions.
You can easily enter this data by using the Demand Control Center in Components >
Demand Center > Demand Control Center. Enter the demand and corresponding pattern
for each of the junctions. To run an EPS go to Analysis > Options, double click on Base
Calculation Options under Steady State/EPS Solver to open the property editor and select
EPS from the Time Analysis Type menu. Click Analysis > Validate, then Compute. You
can have your results shown by a graph with the flow over time by clicking on Calculating

Summary > Graph.
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CHAPTER 5

CASE STUDY

5.1 Description of Study Network

The following section, describes the water distribution/supply networks that are designed using
WATERGEMS.The area of study for the study is B-Block of Surajmal Vihar area in New
Delhi,that houses 265 families,with a total area size of 5 hecatre(0.05 square kilometer) having
population estimate around 5200 people,approximately.

The total length of Pipe to be laid in the area is estimated to be 1614.20 m.

5.1.1 GENERAL

Water distribution networks (WDN) , being an important constituents of a water supply
system,utilizes nearly 74% of installation cost. Population, minimum at residual pressure, peak
factor and fluctutaions in demand are the primary criteria for selecting the pipe size and cost. Value
of Peak factor that is adopted for designing the distribution networks varies across countries
worldwide. The analytical reviewing of peak factor adopted by certain countries is listed
accordingly. Network cost varies directly with the peak factor values. In India,as per the
guildelines listed by CPHEEO the peak factor witnessed in the field alters from 3 to 12 due to
intermittent water supply. Peak factor 2 to 3 is considered to be apt for satisfying the reliability of

network.

WDNs involves a planar arrangement of pipes or link (flowing of water through it) connected to
each other at node which may differ in elevation.The complex network will also include
pumps,valves and reservoirs and. One of the main functions of nodes includes receiving supply

for athe network/system.,or delivering the demand at consumer end.
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5.1.2 SATELLITE IMAGE OF AREA UNDER STUDY (SURAJMAL VIHAR-BLOCK B)

FIG5.1: SATELLTITE VIEW OF THE BLOCK-B SURAJMAL VIHAR,NEW DELHI
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5.1.3 LAYOUT OF PLAN (BLOCK-B,SURAJMAL VIHAR,NEW DELHI)
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OVERHEAD TANK KEY PLAN
o B-BLOCK

FIG 5.2 TYPICAL LAYOUT PLAN OF SURAJMAL VIHAR(B-BLOCK)
Source:Delhi Jal Board (DJB)
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5.1.4 SALIENT FEATURES OF THE AREA (DATA)

The WDN under study is a grid iron system.The salient data of the network is listed below:

ELEMENT VALUE
Area under study 5 hectare(0.05 sg.km)
Consumers/Population estimate: 5200 persons.( 20 person per
plot,3 storey building)
No .of Households under study 265 plots
Demand estimate 165 LPCD(CPHEEO)
Total Length of pipeline to be constructed 1615 m
Number of pipes 30
Number of nodes 26
Number of reservior 1
Material used Ductile Iron(DlI)
Diameter of Pipes(mm) 100,150,200,250
Velocity of Flow(m/s) 0.06-1.42 (m/s)
Eleveation of Reservoir 22 m
Flow Supplied 42 LPS
Peak Factor(CPHEEO) 3.0
Design period of the network 30 years
Reservoir capacity(volume) 1.2 million litres(1200 m3)
Pressure(m-H:0) 22 m (maximum)
No.of Sluice Valves 9
Type of supply Intermittent (6 hours)
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TABLE 5.1 SALIENT FEATURES OF THE STUDY

5.2 DESIGN OF NETWORK USING WATERGEMS
FIG 5.4 WORKING MECHANISM OF WATERGEMS

DRAWING A NETWORK

ENTERING OF DATA(Reservoir
capacity,pipe length,pump details,etc)

RUNNING STEADY
STATE ANALYSIS

EXTENDED PERIOD
SIMULATION(EPS)

VALIDATION OF NETWORK DESIGN

MODIFICATION OF DATA(if required)




5.2.1 LAYOUT OF NETWORK OF AREA
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FIG 5.5 ROUGH SKETCH OF LAYOUT OF NETWORK
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5.2.2 WATERGEMS DESIGN OF WDN

Scenario: Base

J-26

REPLACEMENT OF B-BLOCK SURAJMAL Bentley Systems, Inc. Haestad Methods Bentley WaterGEMS V8i (SELECTseries 2)
VIHAR DISTRIBUTION SYSTEM.wtg Solution Center [08.11.02.31]
Saturday 18-08-2012 27 Siemon Company Drive Suite 200 W Page 1 of 1

Watertown, CT 06795 USA +1-203-755-1666

FIG 5.6 NETWORK DESIGN USING WATERGEMS
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5.3 POPULATION FORECASTING

Water demand estimation is an essential element in effective planning of water resources
management and planning. Forecasting of total quantity of water in the design of WDN plays a
very crucial role in design of operational management. To assure greater reliability of water supply,
a thorough speculation to enhancement of flow and operational programmed is required. Water
demand specifies both current and probable water consumption for given area above definite time
intervals. Estimating water demand requirements is basically stimulating, as various factors,that
directly affect the demand prediction cannot be predicted or forecasted.

GROWTH
RATE

POPULATION INCREASET

140227

203659 63432
295375 91716
442481 147106
649085 206604
764586 115501
956107 191521
1206917 250810

TABLE 5.2: GROWTH OF POPULATION OF DELHI(DELHI NCT ,CENSUS REPORT
2013)
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5.4 DESIGN OF RESERVOIR

Distribution and storage reservoirs,sometimes also referred as Service reservoir which stock the
treated water for distributing water during emergencies situations (like fires, repairs, etc.) and also

to help in satisfying, the hourly,weekly or daily fluctuations that happens in the regular water
demand.

Functions of the Storage Reservoirs:

o To satisfy hourly, weekly and daily variations in demand.

o To maintain the sufficient pressure at the distribution mains.

« Emergency water supply.

« Inour study,this service reservoir might be in service for a larger area,more than one block

of the area,the intermittent duration will be different.
Location and Height of Distribution Reservoirs:

o Location close to the centre of demand or centre of block where supply is provided.
e Water at level in the a reservoir must be for at a sufficient to elevation so as to permit

the gravitational flow at an satisfactory pressure.

Population forecasting using Geometric method: (P = P (2016)+(1+r)")

YEAR GROWTH RATE(r) Decades(n) POPULATION
2016 - 5200
2026 0.35 1 6780
2036 0.40 1 8790
2046 0.42 1 11420

TABLE 5.3: POPLUATION FORECASTING OF SURAJMAL VIHAR(BLOCK-B)
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5.4.1 DEMAND CALCULATIONS:

S.no PARAMETERS SUPPLY RATE
1. Domestic water supply for metropolitan city for 165 Ipcd
piped network
2. Fire Demand 100VP, P is population in
thousand

Table 5.4 Proposed Rate of Supply for Delhi city

400 350

EXPLANATION
B | @ Groundwater
O Surface water
B Total

e Population

300 —

250

250
200

200
150

Population, in millions

150

Withdrawals, in billion gallons per day

100
100

50 50

1950 1955 1960 1965 1970 1975 1580 1585 1990 1595 2000 2005 2010

Trends in population and freshwater withdrawals by source, 1950-2010.

GRAPH.5.1 Change in trends of population with respect to Water supply(source Delhi nct
report 2011)
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5.4.2 Calculations of reservoir size and demand calculations:

i.  Demand cacluations:

e For year 2016
Present demand:165 Ipcd
Population:5200 persons
Total demand:165x5200=858000 million litres(.857 MLD)

e For year 2026
Demand:165 Ipcd
Population :6780
Total demand :6780x165=1118700 miilion litres(1.11 MLD)

e For year 2036
Demand:170 Ipcd
Population:8790
Total Demand:170x8790=1450350million litres(1.45 MLD)

o For year 2046
Demand:175 Ipcd
Population:11420
Total Demand:175x11420=1941400 million litres(1.94 MLD)

Hence, above calculations, analyses the relationship between, per capita demand per day(LPCD)
and total demand ,which will further determine the size of reservoir and decide the dimensions of
reservoir. The method used for forecasting the population is geometric increase method which,
forecast the population for subsequent decades, hence the reservoir designed will be for next 30

years.
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Ii.  Determination of Reservoir Capacity and its size;

As per above calculations ,it is clear that total demand will be increasing in the upcoming
decades with the increase in population,hence the reservoir will be designed for the
capacity ,that can satisfy the demand for atleast 30 years without any further installation of
tank or reservoir to meet consumer demands.Since ,the supply is intermittent,hence the
whole day supply is delivered in 6 hours duration,considering the fact that,in the modern
day lifestyle two-third of daily demand is satisfied in morning three hours of supply,hence
reservoir should deliver around 0.56 MLD of water.and our reservoir has capacity of 1.2

MLD,which is satisfactorily.

Peak factor (CPHEEO guidelines)=3.0

Total demand per day at present=0.857 MLD(0.857m3)

Peak factor *Maximum Daily demand=Peak hour demand

Note:The service reservoir designed to store a volume of 1.2 million litres of water,might

Used to service larger area (more than single block),the supply duration might be different.

Therefore, the installed capacity of reservoir is designed to hold 1.2 million litres or 1200 m? of
water per day.

YEAR POPULATION DEMAND(MLD)
2016 5200 0.85
2026 6780 1.11
2036 8790 1.45
2046 11420 1.97

TABLE 5.5 Demand and population Forecast
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5.5 LEAST COST DESIGN ANALYSIS

Water supply network ,being a crucial component of the water supply network, consumes an
nearly 80% of the total cost of installation. Population,designed peak factor,minumum residual
pressure, and hourly,weekly,monthly variations are the most important factors the characterize the
pipe cost and material. Peak factor value assumed for the for design of distribution and network
varies country to country all across the globe. Different countries had critically reviewed the peak
factor for the analysis of water distribution network. Network cost is directly proportional to the
peak factor.

In India, the type of water supply is Intermittent type, hence peak factor fluctuates from 3 to 12.For
the reliability of the WDS,peak factor can be considered anywhere between 3-5.

For the present case study on Surajmal Vihar,New Delhi peak factor considered is 3.0,as per the
recommendation by CPHEEO.Average daily demand per capita per day is therefore multiplied
with this peak factor to obtain the desired peak capacity of the network.

3.5 +
3 e
2:5
2 -
15 - y=-0.5x+3.5
R2=1
1 -
Peak factor
0 \ ‘
50000 200000 >200000
Population

FIG 5.8 Relationship between Peak factor and population
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In India, the CPHEEO (2013) has recommended following standards of peak factor based upon differnt

population sizes according to the different areas (Table 5.10) for the design of water distribution system.

Population Peak factor
Up to 50000 3.0
50000 to 200000 2.5
Above 200000 2.0

TABLE 5.6 Peak factor considerations for different population size

5.5.1 Empirical estimation of demand

In the US Bureau of Reclamation Design Criteria, the peak instantaneous demand is expressed as

Pf== -05E+35 ......cooovnnn.... (A)

Qp = Pf*D---- cmmmmemmmennnes (B)
Qp=(-05E +35)*135 —oomememmermmmceemceeeee (1)
Qp=(-05E +35)*90  -meemmemmmcemmmeemmeeeee @)
Qp=(-05E +35)*70  —reeommmermmmmermmeeee e 3)
Qp=(-05E +35)*40 —ceeomeeemmeeemmeeee e @)

Peak demands for Corporations, municipalities, town panchayast and rural areas(villages) is
determined/obtained using the equations (1), (2), (3), and (4) respectively, Where Qp denotes the
peak instant demand in litre/minute ,Pf-peak factor, D- per capita demand,E pipe resistance factor.
D depends on status of settlement (corporations/ Municipalities/ town panchayat/ rural areas

respectively)
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5.5.2 Pipe material vs cost relationship

The worth of drinkable/potable water has always been the major concern in the water supply
industry for past few decades. The worsening of treated water could be due to physical,
microbiological or chemical changes that takes place in the water at the time of distribution.
Additionally, pipe-material and subsequent ,decay of the disinfectant agent/chemical can
disturb the quality of the liquid being transported. In this study,we will consider pipes of
different materials one ,of cast iron (CI) pipes and another of ductile iron (DI) pipes,Also the
possibility of HDPE pipes could also be taken into consideration for future work.But,HDPE
pipes being installation expensive ,are not considered feasible for domestic water supply in,
generally in India.

Note:To design a cost efficient water distribution system,design of reservoir is a important
factor in this study,hence one way to cope with high costs of installation of reservoir in future
,valve operated pipelines could be installed in the existing system,that may facilitate, higher
flow rates to meet future needs.

The costs for various sizes of pipes including laying and jointing adopted are tabulated(Table 2).

SI.No | Diameter of pipe, mm Type of material | Cost/metre,
Rs

1 |500 D) 12924

2 |450 Dl 10672

3 [400 DI 9153

4 (300 DI 4639

5 200 Dl 2798

6 |150 Dl 2218

7 1160 HDPE 1425

8 |110 HDPE 994

Table 5.7 Cost pipe including charges for laying and jointing
(Source:Delhi jal board Manual,2016)
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RESULTS AND MODIFICATION OF NETWORK DATA

6.1 VALIDATION OF DESIGN NETWORK

CHAPTER 6

The network constructed using Bentley watergems V8i,needs to be validated.Hence,this validation

process is carried out with the help of FlexTable,as described in Fig 6.1.Basically the flex table

tabulates all the data entered in the network.

The distribution system constructed is GRID IRON type of network and the supply is intermittent

supply, has 30 Pipes,26 nodes and hence respective demands, and hydraulic is obtained through
this FlexTable.6.1

6.1.1 Length and diameter Validation

ID

54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72

Pipe Label

P-1
P-2
P-3
P-4
P-5
P-6
p-7
P-8
P-9

P-10

P-11

P-12

P-13

P-14

P-15

P-16

P-17

P-18

P-19

Length (Scaled) (m)

126
54
61

109
93
87

494

200
90

109

529

415

109
92

120
99

317
97
98
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Start Node
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Stop Node
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Diameter
(mm)
200.0
200.0
150.0
150.0
100.0
100.0
100.0
100.0
100.0
100.0
100.0
100.0
100.0
100.0
100.0
100.0
100.0
100.0
100.0



73 P-20 704 2 9 100.0

74 P-21 696 20 15 100.0
75 P-22 100 21 20 100.0
76 P-23 106 22 21 100.0
77 P-24 121 23 20 100.0
78 P-25 95 24 23 100.0
79 P-26 458 5 24 100.0
80 P-27 97 3 26 100.0
81 P-28 343 26 25 100.0
82 P-29 385 25 22 100.0
84 P-30 118 13 J-26 100.0

TABLE 6.1 Flex Table | for pipe data

Hence above FlexTable denotes the,also the start and stop node of each and every node is
specifically mentioned, with corresponding diameter.Label 1D has been provided to simplify the
notation in the network created.

Pipe Label ID Material Hazen-Williams Flow (L/s)
Coefficient (C)
P-1 54 Ductile Iron 100.0 42
P-2 55 Ductile Iron 100.0 29
P-3 56 Ductile Iron 100.0 19
P-4 57 Ductile Iron 100.0 19
P-5 58 Ductile Iron 100.0 10
P-6 59 Ductile Iron 100.0 10
P-7 60 Ductile Iron 100.0 7
P-8 61 Ductile Iron 100.0 0
P-9 62 Ductile Iron 100.0 6
P-10 63 Ductile Iron 100.0 6
P-11 64 Ductile Iron 100.0 3
P-12 65 Ductile Iron 100.0 0
P-13 66 Ductile Iron 100.0 4
P-14 67 Ductile Iron 100.0 4
P-15 68 Ductile Iron 100.0 1
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P-16 69 Ductile Iron 100.0 1
P-17 70 Ductile Iron 100.0 3
P-18 71 Ductile Iron 100.0 5
P-19 72 Ductile Iron 100.0 5
P-20 73 Ductile Iron 100.0 9
P-21 74 Ductile Iron 100.0 5
P-22 75 Ductile Iron 100.0 2
P-23 76 Ductile Iron 100.0 2
P-24 77 Ductile Iron 100.0 6
P-25 78 Ductile Iron 100.0 6
P-26 79 Ductile Iron 100.0 8
P-27 80 Ductile Iron 100.0 10
P-28 81 Ductile Iron 100.0 8
P-29 82 Ductile Iron 100.0 4
P-30 84 Ductile Iron 100.0 0

Table 6.2 Flex Table 11 for Pipe data

6.1.2 Flow validation of network

Flex table 11(6.2) determines the correlation between pipe material,hazen william’s coefficient and
Flow Supplied.The demand analysis for the population or consumers has been already done in the
previous chapters,and the flow supplied by the reservoir is 42 LPS,including the peak factor
demand ,(peak factor is taken as 3.0).The type of supply is intermittent,servicing for 6 hours of
supply,to satisfy the daily demand of consumers.The reservoir is designed to service at flow rate
of 42 LPS,and store total volume of 1.2 MLD,while considering the present consumers daily

demand can be satisfied reasonably with this flow rate and volume.

Also,the hazen william’s coefficient is taken as 100(as per CPHEEO guidelines),the pipe material
is taken as Ductile iron for the construction of network.Flow of 42 LPS is supplied at the starting
node that is P1 pipe,and then the flow gets reduced subsequently along the flow path to the

consumer end ,and becomes null (zero) at the end of distribution system.
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GRAPH 6.1 Variations of flow for different pipes and nodes

Domestic supply of manual specify maximum water supplies of 70 LPCD for towns ,without
sewerage, and 135 LPCD for towns with existing sewerage and 160 LPCD for metropolitan and
Mega cities, while 165 is recommended by CPHEEO with sewerage system existing. For water
supply through PSPs 40 LPCD is taken into considerations. The unaccounted supply of water is
not included in per capita supply. These LPCD supplies are considered for industrial, domestic
and institutional use. However, if the the bulk water supply is to be provided for such

establishments, then it has be assessed separately.

6.1.3 Velocity and head loss Validation of network

The graph 6.2 depicts the variation of flow velocities ranging from (0.00-1.33) m/s. The flow
velocity is directly proportional to the nodal demands, the junctions where demand is more
,velocity of flow will be more. The maximum flow velocity. Minimum velocity is recommended
as 0.6 mps to avoid deposition & corrosion,and maximum velocity as recommended as 1.42 mps
by CPHEEO. However, where it can be predictable due to varying pipe diameters, lower velocities
can be adopted with acceptable establishment for scouring.Flex table for Velcoity and head loss
gradient is given below using WaterGems. Frictional loss ,as per CPHEEO guidelines can be taken

as,1m/ km per m/s velocity.Flex table for velocity and headloss gradient is depicted below.

46



Label Velocity (m/s) Headloss Gradient Minor Loss Coefficient

(m/m) (Local)
P-1 1.32 0.0015 0.000
P-2 0.94 0.008 0.000
P-3 1.09 0.014 0.000
P-4 1.09 0.014 0.000
P-5 1.23 0.029 0.000
P-6 1.23 0.029 0.000
P-7 0.93 0.017 0.000
P-8 0.06 0.000 0.000
P-9 0.71 0.010 0.000
P-10 0.71 0.010 0.000
P-11 0.33 0.002 0.000
P-12 0.06 0.000 0.000
P-13 0.46 0.005 0.000
P-14 0.46 0.005 0.000
P-15 0.17 0.001 0.000
P-16 0.17 0.001 0.000
P-17 0.37 0.003 0.000
P-18 0.57 0.007 0.000
P-19 0.57 0.007 0.000
P-20 1.11 0.024 0.000
P-21 0.61 0.008 0.000
P-22 0.26 0.002 0.000
P-23 0.26 0.002 0.000
P-24 0.71 0.010 0.000
P-25 0.71 0.010 0.000
P-26 0.97 0.019 0.000
P-27 1.31 0.032 0.000
P-28 1.04 0.021 0.000
P-29 0.52 0.006 0.000
P-30 0.00 0.000 0.000

Table 6.3 Flex Table 111 for Velocity and head loss gradient

47



14

12

08

06

04

0.2

0.035

0.03

0.025

0.02

0.015

o©
o
=

0.005

o

Velocity (m/s)

3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31

GRAPH 6.2 Variation of Flow velocities with different pipes

Headloss Gradient (m/m)
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GRAPH 6.3 Variations of head loss gradient for different pipes
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Hazen-Williams formulae for determination of pressure conduits and Manning’s formulae for
the freeflow conduits’ are generally used by the Manual, for the given value of Hazen William
roughness coefficient(C) and for given value of Manning’s coefficient of roughness. Modified
Hazen william Formula(MHW), prevents the limitations stated in Hazen William formula and can
hence can provide more accurate results.Design recommendations for the use of
ModifiedHazenWilliams Formula and provides the value of roughness coefficient. Therefore the
head loss gradient can be obtained by MHW formula,manually.For this case study, the value of
Hazen William coefficient is taken as 100,and hence head loss and other parameters are determined
using this value.For Flow velocity ranging from 0.00 to 1.42 mps,head loss gradient is computed
to be in the range of 0.000 to 0.035 m/m.

6.1.4 Validation of Hydraulic head and Pressure(m-H:0)

While,computing the hydraulic head,water hammer pressure is a major factor to be taken into
consideration,to avoid the damage of the pipeline. As Per design recommendations, if functioning
pressure and surge pressure together exceeds 1.1 ,times of the internal design pressure then certain
protection measures are considered. In any case,maximum operative pressure and surge pressure
together should exceed the design hydrostatic pressure.Basically,hydraulic head is the elevation
head required for the water supply. In our study, the reservoir is placed at an elevation of 22 m.

It is usually measured as a liquid surface elevation, expressed in units of length, at the entrance (or
bottom) of a piezometer. For a given Reservoir, it the elevation of water level which cannot be
exceeded,Since.in our case the pipeline is laid underground and that is considered as a
datum,therefore the elevation is zero.Consquentley the hydraulic head and pressure for the WDN
will be same.

A flex Table IV (table 6.4) has been obtained through waterGems that clearly shows that hydraulic

grade and pressure in m-HzO are same.for the network.
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Table 6.4 Flex Table IV for Hydraulic head and pressure
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Hydraulic

Grade
(m)
21.55
21.48
21.25
20.87
20.28
19.55
17.41
17.41
17.17
16.90
16.55
16.55
16.67
16.79
16.81
16.83
17.09
17.25
18.17
18.21
18.25
18.45
18.69
18.82
20.73
16.55

Pressure
(m H20)

215
214
21.2
20.8
20.2
19.5
17.4
17.4
17.1
16.9
16.5
16.5
16.6
16.8
16.8
16.8
17.1
17.2
18.1
18.2
18.2
18.4
18.7
18.8
20.7
16.5



Pressure Vs Demand Curve
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Graph 6.4 Pressure vs Demand curve at different nodes

The above graph shows the relationship between pressure(m-H20) and demand at different
nodes.This graph clearly shows that,for nodes with high demands have greater pressure
heads,while there are few nodes where pressure demand is null,but due to minimum pressure

requirements,they have certain values of pressures.

The next section now discusses the various results of the study, demand estimation and data
modifications is presented in the next sections. Parameters which do not satisfy the design

recommmdatuons have been altered accordingly to provide the most reliable network.
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6.2 RESULTS OF THE STUDY

6.2.1 Diameter wise Distribution of network:

WDN of surajmal vihar area will be constituting the total length of pipeline as 1614.20
metres,where Line on CC(cement concerte) road will be 1133.0 meter,and line on bituminous road
will be 481.20 metre.Also sluice valve will be provided like wise according to the diameter of
pipes ,total 9 sluice valves will be provided for the entire WDN,comprising mainly 200
(one),150(one) and 100 mm(seven) diameter sluice valves will be provided respectively for the

pipes having diameter 200,150 and 100 mmm respectively.

Total length of line =) 1614.20 Meter
Total length of line on CC Road (=) 1133.00 Meter
Total length of line on Bituminous =) 481.20 Meter
Road
Detail of Sluice Valve
200 mm Dia (=) 1 No
150 mm Dia (=) 1 No
100 mm Dia =) 6 + 1 Nos(For
AlV)
Total =) 9 Nos

Table 6.5 Details of sluice valve

Pipes Should be laid underground providng a minimum cover of 1-2 mm. Care is taken to localize
other utilities installed under ground and preventing damage to them. All specials and valves
should be accessible and connected with pipe with-out leaving any gaps for later
installations.Width of trenches at bottom end shall be provide with 250 mm allowance on both
the sides of the pipes. Pipelines shall be arranged as straight as possible with minimum
bends(horizontal and vertical). The bends should not be exceeded by 2 degree (recommend by
CPHEEOQ).We should Provide properely bend and thrusts block and anchors at dead ends and
bends. Transportation, and handling and storage should taken care of carefully as recommened by
the manufacture. Pipes with diameter of over 300 mm dia should be held and lowered into trenches

using cranes or block pulley.
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6.2.2 Tabulation of diameter with reference to pipe lengths

REF LINE
1-2
2-3

Total
3-4
4-5

Total
5-6
6-7
7-8
8-9

9-10

10-11

11-12

12-13

13-14

14-15

15-16

16-17

17-18

18-19

19-8

15-20

20-21

21-22

22-25

25-26

26-3
20-23
23-24
24-5
2-9
13-27
Total

LENGTH

29.80
9.90
39.70
15.70
26.50
42.20
20.10
25.00
123.00
52.00
23.00
26.00
142.00
91.00
25.00
26.00
21.00
25.00
83.00
23.00
23.00
175.00
29.00
22.00
96.00
89.00
23.00
27.60
22.60
116.80
172.20
31.00

Table 6.6 Laying of Pipeline on road

1532.30
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DIA
200 mm
200 mm

150 mm
150 mm

100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm
100 mm

Type of Road
Biuminous Road
Biuminous Road

Biuminous Road
Biuminous Road

Biuminous Road
Biuminous Road
Cement Concrete
Biuminous Road
Biuminous Road
Biuminous Road
Cement Concrete
Cement Concrete
Biuminous Road
Biuminous Road
Biuminous Road
Biuminous Road
Cement Concrete
Biuminous Road
Biuminous Road
Cement Concrete
Biuminous Road
Cement Concrete
Cement Concrete
Cement Concrete
Cement Concrete
Biuminous Road
Biuminous Road
Cement Concrete
Cement Concrete
Biuminous Road



6.2.3 Demand Supply of the area

NODE Nos of Self demand @ 50 gallon Peak demand  Self demand
plots per capita considering 4 (KL) in LPS
storied &20 person in (KL)
1 0 0.00 0.00 0.00
2 23 104.42 313.26 3.63
3 0 0.00 0.00 0.00
4 0 0.00 0.00 0.00
5 12 54.48 163.44 1.89
6 0 0.00 0.00 0.00
7 15 68.10 204.30 2.36
8 15 68.10 204.30 2.36
9 23 104.42 313.26 3.63
10 0 0.00 0.00 0.00
11 19 86.26 258.78 3.00
12 19 86.26 258.78 3.00
13 20 90.80 272.40 3.15
14 0 0.00 0.00 0.00
15 16 72.64 217.92 2.52
16 0 0.00 0.00 0.00
17 10 45.40 136.20 1.58
18 10 45.40 136.20 1.58
19 0 0.00 0.00 0.00
20 18 81.72 245.16 2.84
21 0 0.00 0.00 0.00
22 13 59.02 177.06 2.05
23 0 0.00 0.00 0.00
24 13 59.02 177.06 2.05
25 26 118.04 354.12 4.10
26 13 59.02 177.06 2.05
Total 265 1203.10 3609.30 41.77

Table 6.7 Demand analysis of the area

Table 6.7 derives the relationship between population size and demand calcucation.Total of 265
are covered under this study,and the the node and the plots covered under that plot is tabulated

above.Peak factor is taken as 3.0 as per CPHEEO guidelines,also demand has been taken as 50
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gallons (190 LPCD) per capita by considering 3 stories and 20 persons per plot.Hence the LPS is
Calcuated using per capita demand and multiplying it with the peak factor,that comes out to be
41.77 LPS,that makes the round figure as 42 LPS.Subjected to this per capita demand the
reservoir is designed to meet this requirement and deliver 42 LPS of water supply.

6.2.4 Color Coding Of Network

A.Diameter Based
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Fig .6.1 Color coding of network (diameter based)

Above Figure(Fig.6.1) shows the color classification of diameter of pipeline of network.This
classification simplifies the study and modification of data(if any),if any pipeline is to be changed
in the due course of any diameter ,this classification will help in modification of that data,for
instance If we wish to change the diameter of pipelines P1 and P3 ,then by directly with the help
of color coding we can identify it and modify it according to our requirements.Also it simplifies

the study .
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Color

Diameter(mm) Pipelines
Blue >100 P1,P2,P3,P4
Green <=100 Others
Table 6.8 Color Coding Classification of diameter
B.Velocity Based
Network_2 wig Pi%
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Fig 6.2 Color coding classification velocity based

Above Figure(fig.6.2) shows the color classification of Velocity of flow of pipeline of

network.This classification simplifies the study and modification of data, namely(if any),if any
pipeline is to be changed in the due course of any parameter, it helps us identify the critical points
where flow velocity is above or equal to the maximum flow velocity which might cause cavitation
or water hammer phenomena in pipeline ,this classification will help in modification of that data,
for instance If we wish to determine pipelines with velocity greater than 1.32 m/s ,which is the
permintted velocity of flow in the water distribution network.Therefore, P1-P5 and P20 and P 28

are the pipelines that carry flow with velocity greater than ,then by directly with the help of color
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coding we can identify it and provide safety measure,like providing safety valves at these junctions

or nodes. Also, it simplifies the study.

Colour code Velocity(m/s) Pipelines
orange >1.25 P1-P5,P 20,P 28
blue <=1.25 Others

Table 6.9 Color Coding Classification of velocity

C.Head Loss
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Fig 6.3 Color coding classification on the basis of head loss
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Above Figure(fig 6.3) shows the color classification of head loss of pipeline of network.This
classification simplifies the study and modification of data(if any),if any pipeline is to be changed
in the due course of any Parameter.The CPHEEO recommendations,for the head loss gradient in
the water distribution system(WDN),permissible head loss gradient should be equal or less than 1
m/km ,so the above figure clearly shows that all 30 pipelines and 26 nodes follows this design

crtiteria,as ,Head loss is less than designed hence it is satisfied..Also it simplifies the study .

Color Head Loss Gradient(m/km)
Green <=1(CPHEEO)

Table 6.10 Color Coding Classification of Head Loss gradient

D.Pressure at Junction(m-H:0)

Network 2 wig 4 b x

4
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Fig 6.4 Color coding classification on the basis of Pressure at junction
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Above Figure(fig 6.4) shows the color classification of pressure at junction of pipeline of
network.This classification simplifies the study and modification of data(if any),if any pipeline is
to be changed in the due course of any parameter. The CPHEEO recommendations, for the pressure
gradient should be less than the total hydraulic head of reservoir, in this case the elevation of
reservoir is 22 m,and subsequently as per the design recommendations by CPHEEO,the
permissible limit is for one storey7, 17 m for three storied) in the water distribution system(WDN),
,50 the above figure clearly shows that three pressure junctions(2,3,4) are at risk and hence certain
necessary measures have to be adopted to allow them into design criteria. For the present

study,residual pressure is taken 17 m for a three storied building.

Color Residual Pressure(m H:O)
Red >=17.0
Blue 7.0-17.0

Table 6.11 Color Coding Classification of Pressure at junction

Note:The pressure variation by node and per plot consumption ,can be taken into further study ,by
determining the rate at which pressure is changing or varying when, reservoir is in service.
In our study of 265 plots,a total of 26 nodes are covered and 30 pipelines are provided.Number of
plots covered by each node is tabulated in following section,and when evey household is taking
the maximum supply,the pressure variation at each household can be held into study.
But,this study has its shortcomings,as the study will not include the no.of household that have
booster or pumps installed at their ends,which will change the pressure and volume of supply

considerably.
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6.3 MODIFIATIONS OF THE DATA

6.3.1 Modification of diameter

Section 6.1 and 6.2 discussed the validation and results of the network drawn using Bentley
WaterGems V8i software, the network was further validated for certain parameters like, head loss

gradient, junction pressure ,the pressure which is mandatory for the flow to reach at consumer end.

Further with the study,it was found that few pipelines were not following the design guidelines for
the parameters of junction pressure, and by calculations and validation the diameter of pipe has

been modified and tabulated as stated below, so the new network will consist this modified values.

SI.No Pipe number

1 P1

2 P2
3 P3
4 P9
5 P13
6 P14
7 P15

Table 6.12 Modification of diameter of pipelines

6.3.2 Introduction of sluice valves

Sluice valves, (gate valves), are designed to control the flow of fluid through a pipe by raising or
lowering a wedge that blocks flow. They are widely used in water and sewer treatment, and come
in a wide variety of sizes. Most are designed to open slowly (30-50 ,360 degree turns of the handle)

to prevent opening and closing too rapidly, which causes water hammer.
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Designed Diameter,mm

150

150

150

150

150

150

150

Modified Diameter,mm

200

200

200

100

100

100

100



For the present case study,a total of 9 sluice valves are provided according to the diameter of
pipelines,namely 200,150 and 100 mm.Refernce to these valves with their pipeline number is

tabulated as below:

S.no Label ID Pipeline Diameter of Sluice =~ No.of sluice valve
valve,mm
1 o4 P1 200 1
2 56 P3 150 1
3 60 P7 100 1
4 64 P11 100 1
5 70 P17 100 1
6 73 P20 100 1
7 74 P21 100 1
8 79 P26 100 1
9 82 P28 100 1
TOTAL 9

Table 6.13 Details of Sluice valve

6.3.3 Least cost design
As per the data provided by the Delhi jal Board (DJB),cost of civil works for the laying and

jointing of pipes and exacavtion works,laying of thrust blocks,etc is taken as:

Pipe material used For cast iron(Cl) For ductile iron(DI)

COST OF CIVIL WORK: Rs. 3,166,622 Rs. 2,910,686
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Hence,further total cost of laying and jointing of pipe of material used pipe will be added to the

total cost and road restoration charges, removal of surplus malba,labour charges ,etc will add up

to be the total cost. Hence to obtain the most economical design, both the options had to be be

considered.All the rates and estimation cost of civil works and other cost have been inculed with

CPWD manual
(Option I - (Option 11 -
D.l)
COST OF CIVIL
WORK: Rs. 3,166,622 Rs. 2,910,686
ROAD RESTORATION
CHARGES: Length |Width Qty Rate
Bituminous road up to 12
m 481.20 | 1.00 | 481.20 |835.52 |/sqm Rs. 402,052 Rs. 402,052
CC Road 1133.00| 1.00 | 1133.00 |1064.85|/sqm Rs. 1,206,475 Rs. 1,206,475
Removal of surplus malba (Sum of
Bituminous + CC road) 1614.20 | 55.68 [/sqm Rs. 89,879 Rs. 89,879
Total Rs. 1,698,406 Rs. 1,698,406
Add 25% enhancement Rs. 424,601 Rs. 424,601
Total amount of R/R
charges Rs. 2,123,007 Rs. 2,123,007
TOTAL: Rs. 5,289,629 Rs. 5,033,694
ADD 5% FOR
CONTIGENCIES: Rs. 264,481 Rs. 251,685
GRAND TOTAL.: Rs. 5,554,111 Rs. 5,285,378

Table 6.14 Comparison of total cost of pipe materials

Table 6.14 shows the complete abstract of cost,the total cost of civil works is estimated to be ,Rs.

3,166.622 for Option | Cast iron,while For option Il i.e. Ductile Iron(Dl) pipes ,the total cost is

estimated to be Rs. 2,910,686 .All the rates and cost estimation is according to the guidelines of

CPWD manual (2014),the revision of rates has been done and the estimation is done on the basis

of market rates,so calculation of civil works is obtained by the DJB,and post that,the road

restoration charges, addition of 25% enhancements ,also adding 5 % for any kind of contingencies,
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grand total of the project is calculated that is estimated to be Rs.5,554,111 when cast iron is used

as pipe material, while in case of Ductile iron as pipe material it is estimated to be ,Rs 5,285,378.

Therefore,post analysis of least cost design, it is clear, that ductile iron (DI),is the least cost design
for the use of pipe material. Also ductile Iron has been accepted widely due to its wide range of

benefits.

o DI pipes are recyclable and have this major advantage over Cast iron (CI).

« Dl pipes involves little maintenance, hence risk of hazards after installation are lesser as found
in cast iron.

e The Flow of supply water increases readily in the DI pipes.

« DI pipes have gained reputation for being at low risk for leakage,.

o Rusting which is a dominant issue for ClI pipes,is also eliminated in case for DI pipes, Hence
the matter of rusting pipes is also ruled out in these pipes

o DI pipes are considered durable than CI pipes in long run.

e The network in our study has been designed for a span of 30 years so,certainly a durable,
effective and efficient material has to be selected .hence Ductile Iron (DI) pipes have been

used in our study, which covers a total length of 1615 m of pipeline and 30 pipes in total.
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CHAPTER 7

CONCLUSION

7.1 SUMMARY OF THE STUDY

In this thesis,of our present study, design of water distribution network by reliability
considerations and least cost analysis performed. Water distribution networks in India were drawn
using conventional methods and approximate values of certain parameters was considered and
used for the WDN construction, whereas with the evolution of sophisticated computer
programmed and softwares,we can build and analyze these type of problems and obtain a

better,effiecient solution, for a given problem.

Therefore, in our present study,we Understood the the basic principles of creating a Water
distribution Network,Furthur with the help of software called BENTLEY WATERGEMS V8i,the
network was constructed, of given area of study (B-Block Surajmal Vihar,New Delhi).In the
following chapters we validated the network for , satisfaction of the velocity of flow and pressure
controls, and Length and diameter with reference to nodal and piplines were tabulated,as per
CPHEEO ,Nodal demands were satisfied.WDN of surajmal Vihar is designed as per CPHEEO
design recommendations, and finally the network is analyzed for least cost, modifications for the

network for future studies,were suggested in the final chapter.

However, modelers must take into account, in particular, reliability issues and also monetary

limits.
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7.2 CONCLUSIONS

The water distribution network of Surajmal vihar ( Block-B),New Delhi,has been studied using
WATERGEMS software for the following:

1.

To reduce the head losses at household distributions,pipe size of pipeline connecting the
mains and branch line should be increased from half inch to three fourth inch to reduce

head losses by 6-7 times.

A schematic water distribution network is designed as a case study, the design is realized
at the basis of the peak hour loading taking peak factor as 3.0 as per CPHEEO guidelines;
the necessary modification ,in the diameter are done to provide an efficient system.

Also.the designed reservoir capable of supplying with a flow rate of 42 LPS,seems to be

satisfying the demand requirements of the population of over 5000 in the study area.

The installed capacity of reservoir is 1.2 million litres (1200m3),which is sufficient to meet
the demand of population (including the peak factor hourly demand) for next three decades,
if required another tank of required capacity could be installed ,or valve operated pipelines
can be taken into considerations to increase the flow rates with increase in demand ,after

two and half decades, that too if the existing reservoir is not meeting the requirements.

Total Length of pipeline laid is 1614.20 m,out of which 1133.0 m was laid on Cement
concrete road (CC road),and 481.20 m was laid on bituminous road.

Pipelines P1,P2 have 200 mm diameter pipes, P3,P4 have 150 mm diameter pipeline while
other pipleines consists of 100 mm diameter DI pipes.

Velocity of flow ,as per CPHEEO guidelines, should be in the range of 0.06 m/s to 1.42
m/s,minimum velocity should be maintained to avoid any corrosion and sedimentation in
the pipelines, and maximum velocity should not be exceeded to avoid any damage in
pipeline due to water hammer,phenomenan .Hence in our study all 26 nodes and 30
pipelines follows these design criteria and maximum velocity in the network is 1.32
m/s,and some pipelines have zero velocity,because of no demand during average daily

demand,while some velocity is achived at the time of peak flow.
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8.

10.

11.

12.

Head loss gradient ,as per design criteria should be less than 1 m/km for water supply
network.In our study,the head loss gradient is computed directly using hazen William
equation by WaterGems software,and the values comes to be satisfaying the design criteria
,head loss gradient for the water supply network is in the range 0.000 -0.0035 m/m.Hence

,the network is within safe design criteria.

Pressure at junctions,i.e.Nodal Pressure as per design criteria should be within permissible
limits, which is defined by CPHEEO between 7 m to 17 m for this distribution system.
Also,if every household is taking the maximum supply,the pressure variation at each
household can be held into study. But, this study has its shortcomings, as the study will not
include the no.of household that have booster or pumps installed at their ends,which will

change the pressure and volume of supply at other households considerably.

In our case study,three junctions were at risk of violating this design criteria namely,Nodes
2,3 and 4,which was analysed from the watergems color coding criteria of pressue
junctions.Hence to safeguard these nodes or junctions,diameters of the pipelines assocated
with these nodes were modified .So,pipeline P1,P2 and P3 were modified to 200 mm,while
to counterbalance the economy of overall network,P13,P14,and P15 pipelines diameters

changed to 100 mm respectively.

Sluice valves are introduced, these valves are used to control the flow, these valves are
used for the control and frequent operation. For our study of WDN,comprises of 9 sluice
valves of diameters 200,150 and 100 mm are installed respectively .one sluice value
installed at pipeline P1,P3 respectively of 200 and 150 mm diameters respectively ,while
six valves of 100 mm diameters are installed at pipelines P7,P11,P17,P20,P21,P26,P28.

And ,Finally as per least cost design analysis of the network, that includes civil works, road
restoration charges, removal of surplus waste, addition of 25% enhancements and 5% for
any kind of contingencies. The economical design for this system is the use of Ductile Iron

(DI) material for pipelines.

The network constructed with the help of Watergems,is therefore successfully validated for

various design parameters.
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7.3 SCOPE FOR FUTURE WORK

The future work for this study will mainly deal with the improvements of the Linear Programming
algroithims, which is coded in this study. The most important step for the future work is to include
node isolation approach for the decision making process for improving the network, if a limited
amount of money is available. This study,could be further carried for the detection of accidental
contamination in a water distribution network.,conceptually ,the study could be carried out in the
network to detect internal deterioration of water quality in a distribution network.Also, valve

operated pipelines that are installed could be utilized to satisfy the nodal demands in future.

Also, Another important step for the Software WaterGems will be convention of pumps and tank
element,for instance, with the growing population of the area,there might arise a need of
installation of new tanks or reservoirs ,whose study could be simplified with the help of use of
WaterGems V8i in the network. Also, the optimization model should be coupled with simuation
techniques to determine tank diameters, elevations, and locations that meet the required Preflow
durations and storage volumes,Furthur it may be aimed to better model pressure-sensitive nodal
pressures during a pre event and obtain a more accurate estimate of ex-pected conditional pre

damages.

Determination of Chlorine residuals in water distribution systems in another important future
study,use of single decay constant for all pipes in a network may not seem suitable for certain
distribution systems. For future researches and study,primary objective could be to apprehend how
this decay constant might be determined by pipe characteristics, such as network age or pipe
material, also flow supply characteristics indicative of bio film occurrence or any form of corrosion
activity. The chlorine decay model and its implementation within the softwares like EPANET or
Water Gems program will deliver water-supply engineers and designers with a valuable tool for
understanding the performance of chlorine residuals through their system,under a wide range of
variety according to varying hydraulic conditions.A more user friendly interface is aimed for the

future versions of the program.
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